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说明 
1、本实验指导书为《遥感图像处理》课程实验的指导书，能帮助学生更好的完成相关实验，并辅助学生

完成实验报告。 
2、学生根据本指导书完成实验报告，报告内容要求手工填写，“目的”，“要求”，尤其是“方法及步骤”

要书写详细，不能与本实验指导书一样简洁。 
3、“实验成果”以图表的形式粘贴入实验报告。 
4、重点实验的操作过程可详见“天空教室”的课程《遥感图像处理》的实验录相部分。 
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实验一 ERDAS Viewer 的使用 

一、目的 
熟悉软件界面和组成功能模块，掌握软件主窗口（Viewer）的基本操作 
 

二、要求 
1、打开图层的设置和图层的放大，缩小等基本操作 
2、数据叠加显示（混合显示 Blend，卷帘显示 Swipe，闪烁显示 Flicker） 
3、Link 两个图像，进行图像的比较浏览，最后 Unlink 
4、图像对比度调整 
5、光标查询功能（Inquiry Cursor Function） 
6、量测功能（Measurement Function） 
7、文件信息操作（Layer Info） 
8、三维图像操作（Image Drape） 
9、AOI 的使用 
10、Viewer 其它菜单的熟悉（Raster、Vector、Annotation） 
 

三、方法与步骤 
1、打开两个图层（lanier.img 和 Insoils.img） 
2、实现放大、缩小 
3、数据叠加显示 
4、打开 eldodem.img（下层 DEM）和 eldoatm.img（上层 TM 图像），实现三维图像操作 
5、其它功能操作 
 

四、实验成果 
1、数据叠加显示图 
2、三维图像操作图 
3、AOI 操作图 
 
 

实验二 卫星影像及航空影像的几何校正 

一、目的 
掌握卫星影像及航空影像的几何校正方法 

 

二、要求 
1、 实现资源卫星图像校正 
2、 实现遥感图像仿射变换 
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三、方法与步骤 
 
 
 
 
 
练习一、Viewer to Viewer 卫星影像采点模式 
A、显示文件（Display Files） 
1、打开两个 Viewer，Session | Tile Viewers 使它们并排 
2、在 Viewer1 中，选择 tmAtlanta.img，Gray Scale，Display Layer 为 2。（要纠正的图像） 
3、在 Viewer2 中，选择 panAtlanta.img（已经纠正的参考图像） 
4、在 Viewer1 中，选择 Raster | Geometric Correction 
5、选择 Polynomial，单击 OK，出现 Geo Correction Tools 
6、在 Polynomial Model Properties dialog 中选择 Close，出现 GCP Tool Reference Setup dialog 
7、选择 Existing Viewer，OK 
8、在 Viewer2 中，单击 panAtlanta.img（选择参考图像） 
9、在弹出的 Reference Map Information dialog 中 OK 
10、出现 Chip Extraction Viewers 和 GCP Tool 
 
B、选择地面控制点（Select GCPs） 
1、选择如图如示的四个控制点 
2、将 GCP Tool 中的 color 设为 Red 
3、分别刺完四对同名像点（第四个点会自动预测） 
4、系统自动计算相关误差（在 GCP Tool 中显示） 

 
C、检查点（Digitize Check Points） 
1、选择 5 号点所在行，则此行改变颜色为 Yellow 
2、Edit | Set Point Type | Check，则下面刺的点都为 check points 
3、Edit | Point Matching 
4、在 GCP Matching dialog 中，Correlation Threshold 为 0.8 
5、选中 Discard Unmatched Point，Close 

准备工作 
输入原始

数字图像

建立纠正

变换函数

确定输出

图像范围

逐个像素几

何位置变换

像素亮度

值重抽样 
输出纠正

后的图像
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6、画出 5 对 check points 
7、单击 the Compute Error 图标  
8、在 Geo Correction Tools 中选择 Model Properties 图标  
 
D、重采样图像（Resample the Image） 
1、在 Geo Correction Tools 中单击 Resample，出现 Resample dialog 
2、Output File 中键入 tmAtlanta_georef.img 
3、Resample Method 中选择 Bilinear Interpolation 
4、选择 Ignore Zero in Stats 
5、OK 
 
E、验证（Verify the Rectification Process） 
在两个 Viewer 中打开图像，采用 Link 的方法，使用 Inquire Cursor 进行检查。 
 
练习二、航空影像正射校正（Concrete Orthorectify Process） 
1、打开 ps_napp.img 图像 
2、Raster|Geometric correction|Camera 
3、输入下列航摄模式参数（参数由航空影像销售商提供） 

Elevation File:ps_dem.img 
Elevation Unit:meters 
Principal Point:X 为-0.004;y 为 0.000 
Focal Length:152.804 
Focal Units:Millimeters 
选中 Account for Earth's Curvature 
Number of Iterations:5 

4、确定内定向参数 

点击 Fiducials 标签，选择第一种框标类型，单击图标 ，按提示选中 Viewer1，利用图标 进行相关

框标点的选择，并输入相应图像坐标，如下图所示。直至选完四个点（注意四个点的位置顺序）。当误差

（Error）<1 则接受；当误差（Error）>1，则重来。 

 
5、设置投影参数 

点击 Projection 按钮，选择 Add/Change Projection，点击 Custom 按钮，定义下列投影参数。 
Projection Type:UTM 
Spheroid Name:Clarke 1866 
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Datum Name:NAD27 
UTM Zone:11 
North or South:North 

6、OK 
7、定义 Map Units 为 meters，Apply|Save As 为 camera.gms，OK 
8、读取地面控制点 

在 Geo Correction Tools 对话框中，点击 Start GCP Editor 图标 ，选择 GCP File:ps_camera.gcc,OK 

在GCP Tool对话框中，点击Calculate图标 ，系统自动求解模型（Solve Model），计算中误差（RMS）、

残差（Residuals）和控制点 X，Y 坐标值误差。 
在 Camera Model Properties 对话框中点击 Save 按钮 

9、图像重采样（Resample） 

单击图像重采样图标 ，设置 OutFile,OK 

 
注意： 

图像校正标定（Calibration），只是在原航空影像文件中将校正的数字模型以辅助信息层的方式保存，

而不进行重采样、不生成新文件。第当校正标定图像被使用时，相应的校正模型也必须被调用。由于图

像校正标定有一定的不足，一般直接进行图像重采样（Resample）。 
 

四、实验成果 
1、航空影像正射校正图 
2、Viewer to Viewer 卫星影像采点模式图 
 
 

实验三 雷达图像的几何纠正 

一、目的 
实现雷达图像的正射处理与校正 
 

二、要求 
1、利用 OrthoRadar 模块，进行 SAR 图像地理编码 
2、对 SAR 图像进行正射校正 
 

三、方法与步骤 
练习一、基本雷达图像处理 
1、 斑点噪声压缩（loplakebed.img） 
Radar/Radar Interpreter/Speckle Suppression 
 

（1） 输入文件：loplakebed.img，选中 Calculate Coefficient of Variation(计算变异系数)，OK 
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（2） 主菜单 Session|Session Log，查阅变异系数为 0.274552 
（3） 在 Radar Speckle Suppression 对话框中输入上述变异系数 0.274552，OK 
（4） 对比处理效果 

 
2、 边缘增强处理（loplakebed.img） 
Radar/Radar Interpreter/Edge Enhancement，选择滤波器 Filter 为 Prewitt Gradient 
 
3、 雷达图像增强（radar_glacier.img） 
Radar/Radar Interpreter/Image Enhancement 

（1） 输入 Radar_glacier.img，输出 aa.img，Filter 为 Gamma-MAP，变异系数为 0.270751，进行斑

点压缩 
（2） 执行 Wallis 滤波：Radar/Radar Interpreter/Image Enhancement/Wallis Adapter Filter 
（3） 输入文件 aa.img，对比度增强系数 Multiplier 为 3，OK 

 
4、 图像纹理分析（flevolandradar.img） 
Radar/Radar Interpreter/Texture Analysis 
（1）输入文件 flevolandradar.img，移动窗口 Window Size 为 5，分析算子 Operators 为 Skewness，OK 
 
练习二、地理编码 SAR 图像 
将雷达图像从原始的传感器坐标转换到地图投影坐标系统 
1、 在 Viewer 中显示雷达图像 Deathvalley_Radarsat.img 
2、 查阅图像信息：Utility/LayerInfo，可以看到没有地图投影信息 
3、 选择几何校正模型：Viewer 菜单 Raster/Geometric Correction，选择 radarsat，OK 
4、 应用模型参数 

General 选项卡，Geocode SAR Imae；Projection 选项卡，Add/Change Projection 按钮，Custom 
Projection Type 为 UTM，Spheroid Name 为 Clarke 1866，Datum Name 为 NAD27(west CONUS)，UTM 
Zone 为 11，North or South 为 North，OK 

 
5、 图像重采样 
6、 检验地理编码图像 
 
练习三、正射校正 SAR 图像 
不光将雷达图像从原始的传感器坐标转换到地图投影坐标系统，还对地形变形进行校正 
1、 显示雷达图像（Deathvalley_Radarsat.img） 
2、 查阅图像信息 
3、 选择几何校正模型在 Viewer 中，Raster/Geometric Correction，选择 Radarsat 模型 
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4、 应用模型参数 
General 选项卡，Orthorectify SAR Image，Input DEM 为 deathvalley_30m_dem.img 
Projection 选项卡，Add/Change Projection 按钮，Custom 
Projection Type 为 UTM，Spheroid Name 为 Clarke 1866，Datum Name 为 NAD27(west CONUS)，UTM 
Zone 为 11，North or South 为 North，OK 

5、 图像重采样  

6、 检验正射校正图像 
 

四、实验成果 
1、基本雷达图像处理结果图 
2、地理编码 SAR 图像 
3、正射校正 SAR 图像 
 

实验四 辐射校正与图像镶嵌 

一、目的 
实现遥感图像的图像镶嵌与分幅裁剪 
 

二、要求 
掌握相关原理，并用软件实现相关操作 
 

三、方法与步骤 
练习一、航空像片镶嵌(Mosaic Using Air Photo Images) 
A、设置输入图像（Set Input Images） 
1、Viewer1 中打开 air-photo-1.img 
2、Viewer2 中打开 air-photo-2.img 
3、主工具条选择 DataPrep 图标 
4、Mosaic Images 
5、Viewer1 中 AOI | Tools 
6、选择 Polygon 工具，画出包含整个图像的斜边框 
7、File | Save | AOI Layer As 
8、输入 template.aoi，OK 
9、在 Mosaic Tool viewer 中选择 Edit | Add Images 
10、选择 air-photo-1.img 
11、选择 Template AOI，Set 
12、在 Choose AOI dialog 中选择 File 选项 
13、选择 template.aoi，OK 
14、在 Mosaic Tool viewer 中选择 Edit | Image List，出现 Mosaic Image List 
15、Add，air-photo-2.img 
16、选择 Compute Active Area 选项 
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17、Add 
 
B、标出拼接区（Identify Areas of Intersection） 

1、选择 Input 图标 ，确定当前为输入图像状态 

2、单击 Image Matching 图标  

3、Matching Method 中选择 Overlap Areas，OK 

4、单击 Intersection 图标 ，当前状态为拼接状态 

5、在两图像重叠部分单击，则高亮显示 

6、单击 Cutline Selection 图标  

7、使用放大工具观察交接处 

8、从 AOI tool palette 选择 Line 工具  

9、在交叉处画出折线 

10、单击 AOI Cutline 图标  

11、在 AOI Source 中选择 Viewer 

12、单击 Function 图标  

13、Intersection Type 选择 Cutline Exists 
14、Select Function 选择 Cut/Feather 
15、Apply，Close 
 
C、定义输出图像（Define Output Images） 

1、单击Output图标 ，当前状态为输出状态 

2、选择Output Image工具  

3、Define Output Map Area(s)为Union of All Inputs，OK 
 
D、运行图像镶嵌（Run the Mosaic） 
1、选择Process | Run Mosaic 
2、Output File Name 为 AirMosaic 
3、勾上 Stats Ignore Value 选项 
4、OK 
5、在 Viewer 中显示 
 
练习二、卫星图像镶嵌 
加载 wasia1_mss.img；wasia2_mss.img；wasia3_tm.img，其它同练习一。 
 
练习三、分幅裁剪 
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四、实验成果 
航空像片镶嵌成果图 
分幅裁剪图 
 

实验五 空间增强处理、辐射增强处理 

一、目的 
实现遥感图像的空间增强处理和辐射增强处理 
 

二、要求 
掌握空间增强处理和辐射增强处理，用软件完成相关操作 
 

三、方法与步骤 
1、 卷积增强（lanier.img） 
单击 Interpreter 图标，选择 Spatial Enhancement/Convolution 
2、 非定向边缘增强（lanier.img） 
单击 Interpreter 图标，选择 Spatial Enhancement/Non_directional Edge 
3、 聚焦分析（lanier.img） 
单击 Interpreter 图标，选择 Spatial Enhancement/Focal Analysis 
4、 纹理分析（lanier.img） 
单击 Interpreter 图标，选择 Spatial Enhancement/Texture 
5、 锐化增强（panatlanta.img） 
单击 Interpreter 图标，选择 Spatial Enhancement/Crisp 
6、 LUT 拉伸（mobbay.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/LUT Stretch 
7、 直方图均衡化（lanier.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Histogram Equalization 
8、 直方图匹配（匹配文件 wasia1_mss.img，匹配参考文件 wasia2_mss.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Histogram Matching 
9、 亮度反转（loplakebedsig357.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Brightness Inversion 
10、去霾处理（klon_tm.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Haze Reduction 
11、降噪处理（dmtm.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Noise Reduction 
12、去条带处理（tm_striped.img） 
单击 Interpreter 图标，选择 Radometric Enhancement/Destripe TM Data 
 

四、实验成果 
空间增强处理和辐射增强处理的结果图 
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实验六 傅立叶变换 

一、目的 
傅立叶变换是首先把遥感图像从空间域转换到频率域，然后在频率域上对图像进行滤波处理，减少或消

除周期性噪声，再把图像从频率域转换到空间域，达到增强图像的目的。 
 

二、要求 
掌握相关原理，并用软件实现相关操作 
 

三、方法与步骤 
练习一、傅立叶变换 
A、创建.fft 层(Create an .fft Layer) 
1、新建 Viewer，打开选择 TM_1.img，Gray Scale，Layer 1 打开 

2、主工具条中选择 Interpreter 图标  

3、Fourier Analysis|Fourier Transform 
4、Input File 为 TM_1.img. 
5、Output File 自动产生 TM_1.fft 
6、Select Layers 设为 1:1 
7、OK 
 
B、启动 Fourier 变换矩阵编辑(Start the Fourier Transform Editor) 
1、在 Fourier Analysis 菜单中选择 Fourier Transform Editor，出现 Fourier Editor 对话框 
2、单击 Open 图标，选择上面创建的 TM_1.fft 
3、OK 

 

 
C、使用菜单选项进行编辑(Edit Using Menu Options) 
Use Low-Pass Filtering 
1、在 Fourier Editor 中选择 Mask| Filters 
2、Filter Type：High Pass（低通滤波） 
3、Window Function 设为 Ideal. 
4、Radius 为 80.00. 
5、OK 
6、File | Save As 
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7、输入 TM1lowpass.fft，OK 
8、单 Run 图标 或者选择 File |Inverse Transform 
9、Output File 输入新文件 inverse_TM1.img ，OK 
10、在 Viewer 中观看，与原图作比较 
11、同理可使用 Circular Mask、Rectangular Mask、Wedge Mask 
 
D、使用鼠标工具进行编辑（Edit Using Mouse-Driven Tools） 
1、打开 TM_1.fft 
2、Edit | Filter Options 
3、Window Function 选择 Hanning，OK 
4、选择 High-Pass Filter 图标  
5、鼠标处在图像中心，按下拉圆，令 u 大概为 30 
6、File | Save As 为 TM1highpass.fft，OK 
7、File | Inverse Transform 或者 Run 图标 
8、在 Out File 中输入 TM1highpass.img 
9、在 Viewer 中观看 TM1highpass.img 

 
E、契形掩膜（Wedge Mask） 
1、确定辐射线的走向 

用鼠标单击辐射一上亮点的中心，其坐标显示在状态条上（36,-185），计算角度：-actan(-185/36)=78.99 
2、定义契形掩膜参数（Mask|Wedge Mask 菜单） 

Window Function:Hanning 
Center Angle:78.99 
Wedge Angle:10 
Central Gain:0.00 

3、保存傅立叶处理图像 
4、执行傅立叶逆变换  

 
练习二、周期噪声去除（Periodic Noise Removal） 

周期噪声去除通过傅立叶变换来自动消除遥感图像中诸如扫描条带等周期性噪声。输入图像首先被

分割成相互重叠的 128×128 的像元块，每个像元块分别进行快速傅立叶变换，并计算傅立叶图像的对数

亮度均值，依据平均光谱能量对整个图像进行傅立叶变换，然后再进行傅立叶逆变换。这样，原始图像

中的周期性噪声就会明显减少或去除。 
在 Fourier Analysis 菜单中选择 Periodic Noise Removal 

1、Input File：tm_1.img 
2、Output File：tm_1_noise.img 
3、Minimun Affected Frequency：10 
 
练习三、同态滤波（Homomorphic Filter） 

同态滤波是应用照度/反射率模型对遥感图像进行滤波处理，常常用于揭示阴影区域的细节特征。 
在 Fourier Analysis 菜单中选择 Homomorphic Filter 

1、 Input File：tm_1.img 
2、 Illumination Gain：0.5 
3、 Reflectance Gain：2.0 
4、 Cutoff Frequency：5 
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四、实验成果 
1、傅立叶变换图 
2、周期噪声去除图 
 

实验七 彩色增强与图像运算 

一、目的 
将灰度图像变为彩色图像以及进行各种彩色变换，明显改善图像的可视性。并对两幅或多幅单波侧面遥

感图像进行一系列代数运算，从而达到某种增强的目的。 
 

二、要求 
掌握相关原理，并用软件实现相关操作 
 

三、方法与步骤 
1、 RGB 系统变换为 HIS 系统，并进行逆变换 
Input File：dmtm.img；确定参与的波段：R4，G3，B2 

（1） 单击 Interpreter 图标，选择 Spectral Enhancement/RGB to HIS 
（2） 输入文件：dmtm.img；确定参与的波段：R4，G3，B2；选中 Ignore Zero in Stats；设定输出

文件 
（3） 单击 Interpreter 图标，选择 Spectral Enhancement/ HIS to RGB 
（4） 输入文件：第 2 步的输出文件；确定参与的波段：Intensity 为 1，Hue 为 2，Sat 为 3， OK 

2、 加法运算（lainer.img；lndem.img） 
（1） 单击 Interpreter 图标，选择 Utilities/Operators 
（2） 如下图进行设置 

 
3、 自然色彩变换 
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（1） 单击 Interpreter 图标，选择 Spatial Enhancement/Natural Color 
（2） 输入文件：spotxs.img；输入光谱范围：NI3，R2，G1 

 
4、 变化检测 

（1） 单击 Interpreter 图标，选择 Utilities/Change Detection 
（2） 如下图进行设置（Before Image：atl_spotp_87.img；After Image：atl_spotp_92.img） 

 

 
5、 图像融合 
A、简单融合 

（1） 单击 Interpreter 图标，选择 Spatial Enhancement/Resolution merge 
（2） 如下图设置输入图像（高分辨率图像 spots.img，多光谱图像 dmtm.img） 
（3） 选择融合方法。Erdas 提供了三种融合方法 Principal Component(主成分变换法 )、

Multipalcative(乘积变换)、Brovey transform(比值变换)。 

 
 



《遥感图像处理》实验指导书              苏州科技学院 环境科学与工程学院 空间信息与测绘工程系  杨朝辉编写 

 14

 
B、传感器融合 
Radar/Radar Interpreter/Image Enhancement/Sensor Merge 

 
 
结果比较 
打开 Flood_tm147_radar.img(1,2,3)，打开 Merge.img(1,2,3) 
 
C、小波融合 
在 Spatial Enhancement 菜单中选择 wavelet Resolution Merge，弹出对话框如下： 

 

 

四、实验成果 
彩色增强与图像运算成果图 
 

实验八 多光谱增强 

一、目的 
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采用对多光谱图像进行线性变换的方法，减少各波段信息之间的冗余，达到保留主要信息，压缩数据量，

增强和提取更具有目视解译效果的新波段数据的目的。 

二、要求 
掌握相关原理，并用软件实现相关操作 
 

三、方法与步骤 
1、K-L（Karhunen-Loeve）变换，即主成分变换（lanier.img） 
（1） 单击 Interpreter 图标，选择 Spectral Enhancement/Principal Components 
（2） 如下图进行设置 

 
（3） 打开 principal.img，RGB 分别对应 1，2，3 
 
2、K-T（Kauth-Thomas）变换，即缨帽变换（lanier.img） 
（1） 单击 Interpreter 图标，选择 Spectral Enhancement/Tasseled Cap 
（2） 如下图进行设置 
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（3）打开 a.img，RGB 分别对应 1，2，3 
 
3、复杂融合 
数据准备：单波段 spot 影像 Spots.img: 32.8 feet；多波段 tm 影像 Dmtm.img: 81 feet 

 
 
（1）将单波段 spots.img 的分辨率调整为 40.5 feet 
DataPrep/Mosaic Images 
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（2）将多波段 dmtm.img（4，3，2 波段）从 RGB 转化至 IHS 
Interpreter/Spectral Enhancement/ RGB to IHS  

 
 
（3）将调整分辨率后的 SPOT 影像各个 Pixel value 除以 255(在 ERDAS 里面 Intensity 定义从 0-1.0，所

以需将光谱度值除以 255)。Modeler/Model Maker 打开 Spatial Modeler 
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（4）抽出彩色 TM 的 IHS 影像(temp.img)中的 H 层及 I 层，与单色影像除以 255 的影像(spot255.img)叠
合，产生一新的彩色 IHS 影像。 
Image Interpreter/Utilities/Layer Stack... 
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（5）将上述 IHS 彩色影像转为 RGB 彩色影像。 
Interpreter/Spectral Enhancement/IHS to RGB 

 

 
（6）比较结果 
打开 dmtm.img(4,3,2)和 rgb.img(1,2,3) 
 
 

四、实验成果 
1、主成分变换图 
2、缨帽变换图 
3、复杂融合图 
 

实验九 非监督分类 

一、目的 
实现遥感图像的非监督分类；对分类结果进行后处理 
 

二、要求 
掌握相关原理，并用软件完成相关操作 
 

三、方法与步骤 
A、使用非监督分类（Use Unsupervised Classification） 

1、在主工具条上选择 DataPrep 图标  
2、选择 Unsupervised Classification 
3、在 Input Raster File 中选择 germtm.img 
4、在 Output File 中键入 germtm_isodata.img 
5、Number of Classes 设为 10 
6、Maximum Iterations 为 24 
7、Convergence Threshold 为 0 .950 
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8、OK 
 

B、验证分类（Evaluate Classification） 
1、Viewer 中 File | Open | Raster Layer,打开 germtm.img 
2、设置 R，G，B 为 4，5，3 
3、再添加打开 germtm_isodata.img, 
4、Raster | Attributes 
5、Edit | Column Properties，为了更方便的进行比较 
6、将 Opacity 移到 Histogram 下 
7、将 Class_Names 移到 Color 下 
8、OK 
9、选择整个 Opacity 列 
10、右击选择 Formula，出现 Formula 对话框 
11、单击 0，Apply（全设为透明） 
12、单击 Class1 的 color 设为 Blue 
13、Opacity 设为 1 
14、Utility | Flicker 进行比较 
15、Class 1 的 Class Names 为 Water 
16、同理 Class 2 为 Forest，Pink 

 
C、分类后处理 
1 分类重编码 
（1）单击 Interpreter 图标，选择 GIS Analysis/Recode 
（2）设置输入图像和输出图像，单击 Setup Recode，改变 New Value 字段的取值，进行合并 
2 聚类统计 
（1）单击 Interpreter 图标，选择 GIS Analysis/Clump 
（2）设置输入图像 germtm_class.img（分类结果图），输出图像 germtm_clump.img（中间文件） 
 
3 过滤分析 
（1）单击 Interpreter 图标，选择 GIS Analysis/Sieve 
（2）设置输入图像 germtm_ clump.img（中间文件），输出图像 germtm_sieve.img，最小图斑（Minimum 
Size）为 16。 注：最小图斑小于 16 的斑块单独成为一类 
 
4 去除分析 
（1）单击 Interpreter 图标，选择 GIS Analysis/Eliminate 
（2）设置输入图像 germtm_clump.img（中间文件），输出图像 germtm_ eliminate.img，最小图斑（Minimum 
Size）为 16。注：最小图斑小于 16 的斑块合并入附近的其它类 
（3）Viewer 中打开 germtm_ eliminate.img，菜单 Raster/Attributes，将颜色设成与原始分类图一致。 
 

四、实验成果 
非监督分类图，分类后处理图 
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实验十 监督分类 

一、目的 
实现遥感图像的监督分类 

二、要求 
掌握相关原理，并用软件实现相关操作 
 

三、方法与步骤 
练习一、定义分类模板（Define Signature Using signature Editor） 
    监督分类是基于分类模板来进行的，而分类模板的生成、管理、评价、和编辑等功能是由分类模板

编辑器来负责的。毫无疑问，分类模板生成器是进行监督分类一个不可缺少的组件。 
在分类模板生成器中，生成分类模板的基础是原图像和（或）其特征空间图像。因此，显示这两种

图像的视窗也是进行监督分类的重要组件。 
A、应用 AOI 绘图工具获取分类模板信息 
1、在 Viewer 中打开 germtm.img，R，G，B 分别为 4，5，3 
2、主工具条中选择 Classifier 图标，选择 Signature Editor 
3、在 Signature Editor 中选择 View | Columns 
4、选择 Red, Green, Blue 三行，然后反选，Apply，Close 
5、 Viewer 中选择 AOI | Tools 
6、选择 Polygon 工具 
7、放大图像，选择绿地画出来（农作物区域） 
8、在 Signature Editor 中 Edit | Add 
9、令 Signature Name 为 Agricultural Field_1，Color 选择绿色；同理加入若干区域，进行合并。 
10、同样画出黑色区（水体），蓝色区（建筑），红色区（林地） 
 
B、应用 AOI 扩展工具获取分类模板信息 
11、Viewer 中选择 AOI | Seed Properties 

12、选中图标  

13、选中 Area，单位为 pixels，值为 300 
14、Spectral Euclidean Distance 为 10 
15、单击 Options 按钮 
16、选中 Include Island Polygons 
17、AOI tool palette 中选择 Region Grow 图标  
18、单击图像的亮红色区域（林地区域 1） 
19、在 Signature Editor 中 Edit | Add，Forest_1,Yellow 颜色 
20、同理单击图像的暗红色区域（森林区域 2），Forest_2,Pink 
21、保存分类模板  
 

练习二、评价分类模板（Evaluating Signatures） 
分类模板建立之后，就可以对其进行评价，删除、更名、与其它分类模板合并等操作。分类模扳的

合并可使用户应用来自不同训练方法的分类模板进行综合复杂分类，这些模板训练方法包括监督、非监
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督、参数化和非参数化。 
分类模板评价工具包括： 
    ·  Alarms：分类报警工具 
    ·  Contingency matrix：可能性矩阵 
    ·  Feature objects：特征对象 
    ·  Feature Space to image masking：特征空间到图像掩模 
    ·  Histograms：直方图方法 
    ·  Signature separability：分类的分离性 

·  Statistics：分类统计分析 
 
A、分类预警评价 
分类模板报警工具根据平行六面体决策规则（Parallelepiped division rule）将那些原属于或估计属于

某一类别的像元在图像视窗中加亮显示，以示警报。一个报警可以针对一个类别或多个类别进行。如果

没有在 Signature Editor 中选择类别，那么当前活动类别（Signature Editor 中“>”符号旁边的类别）就被

用于进行报警。 
第一步：产生分类预警掩膜 
1、在 signature Editor 中选择所有类别，View /Image Alarm，打开 Signature Alarm 对话框 
2、选中 Indicate Overlap，使同时属于两个及以上分类的像元叠加预警显示，将颜色设为红色 
3、点击 Edit Parallelepiped Limits 按钮，打开 Limits 对话框 
4、点击 SET 按钮，打开 Set Parallelepiped Limits 对话框 
5、设置计算方法（Method）：Minimum/Maximum；选择使用的模板（Signature）：Current；OK 
6、Close（关闭 Limits 对话框），返回 Signature  Alarm 对话框 

7、OK（执行报警评价，形成报警掩膜） 

 根据 Signature  Editor 中指定的颜色，选定类别的像元显示在原始图像视窗中，并覆盖在原图像之上， 

形成一个报警掩膜。 

 
第二步：利用 Flicker 功能查看报警掩膜 

    第三步：删除分类报警掩膜 

1、视窗菜单条 View/Arrange Layers 菜单 

    2、打开 Arrange Layers 对话框，右键点击 Alarm Mask 图层，选择 Delete Layer 

    3、Alarm  Mask 图层被删除 

 
 
B、可能性矩阵 

可能性矩阵（Contingency Matrix）评价工具是根据分类模板，分析 AOI 训练区的像元是否完全落

在相应的类别之中。通常都期望 AOI 区域的像元分到它们参于训练的类别当中，实际上 AOI 中的像元对

各个类都有一个权重值，AOI 训练样区只是对类别模板起一个加权的作用。Contingency  Matrix 工具可

同时应用于多个类别，如果你没有在 Signature  Editor 中确定选择集，则所有的模板类别都将被应用。 

可能性矩阵的输出结果是一个百分比矩阵，它说明每个 AOI 训练区中有多少个像元分别属于相应的

类别。 

1、在 signature Editor 中选择所有类别   

    2、Evaluation/Contingency，打开 Contingency Matrix 对话框，如下图进行设置 
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然后，IMAGINE 文本编辑器（Text Editor）被打开，分类误差矩形矩阵将显示在编辑器中供查看统

计，该矩阵的局部（以像元数形式表达部分）如下 

 
 

练习三、执行监督分类（Perform Supervised Classification） 
1、在 Signature Editor 中选定全部行 
2、Classify | Supervised 
3、Output File 为 germtm_superclass.img 
4、勾上 Output Distance File 
5、Filename 为 germtm_distance.img 
6、单击 Attribute Options 
7、选中 Minimum, Maximum, Mean, and Std. Dev. 
8、确定 Layer 被选择，Close 
9、Non-parametric Rule 选择 Feature Space 
10、OK 
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练习四、评价分类结果 
A、分类叠加（Classification Overlay） 

分类叠加就是将专题分类图像与分类原始图像同时在一个视窗中打开，将分类专题层置于上层，通

过改变分类专题的透明度（Opacity）及颜色等属性，查看分类专题与原始图像之间的关系。对于非监督

分类结果，通过分类叠加方法来确定类别的专题特性、并评价分类结果。对监督分类结果，该方法只是

查看分类结果的准确性。 
 
B、分类重编码 

对分类像元进行了分析之后，可能需要对原来的分类重新进行组合（如将林地 1 与林地 2 合并为林

地），给部分或所有类别以新的分类值从而产生一个新的分类专题层。 
 
C、分类精度评估 

 分类精度评估是将专题分类图像中的特定像元与已知分类的参考像元进行比较，实际工作中常常是将

分类数据与地面真值、先前的试验地图、航空相片或其它数据进行对比的途径之一。下面是具体的操作

过程： 
第一步：在视窗中打开原始图像 
在 Viewer 中打开分类前的原始图像，以便进行精度评估。 
 
第二步：启动精度评估对话框 
ERDAS 图标面板菜单条：Main/Image Classification /Classification 
或 ERDAS 图标面板工具条：点击 Classifier 图标/Accuracy Assessment 菜单项，打开 Accuracy 

Assessment 对话框 
Accuracy Assessment 对话框中显示了一个精度评估矩阵（Accuracy Assessment Cellarray）。精度评估

矩阵中将包含分类图像若干像元的几个参数和对应的参考像元的分类值。这个矩阵值可以使用户对分类

图像中的特定像元与作为参考的已知分类的像元进行比较，参考像元的分类值是用户自己输入的。矩阵

数据存在分类图像文件中。 
 
第三步：打开分类专题图像 
1、Accuracy  Assessment 对话框菜单条：File→Open 
2、打开 Classified Image 对话框 
3、在 Classified Image 对话框中确定与视窗中对应的分类专题图像 
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4、OK（关闭 Classified Image 对话框），返回 Accuracy Assessment 对话框 
 
第四步：将原始图像视窗与精度评估视窗相连接 
Accuracy Assessment 对话框： 

1、工具条：点击 Select Viewer 图标 （或菜单条：选择 View 菜单的 Select Viewer）  

2、将光标在显示有原始图像的视窗中点击一下 
3、原始图像视窗与精度评估视窗相连接 
 
第五步：在精度评价对话框中设置随机点的色彩 
Accuracy Assessment 对话框： 
1、菜单条 View →Change Colors 菜单项，打开 Change color 面板 

 
2、在 Points with no Reference 确定没有真实参考值的点的颜色 
3、在 Points with Reference 确定有真实参考值的点的颜色 
4、OK（执行参数设置），返回 Accuracy Assessment 对话框 
 
第六步：产生随机点 
本步操作将在分类图像中产生一些随机的点，随机点产生之后，需要用户给出随机点的实际类别。

然后，随机点的实际类别与在分类图像的类别将进行比较。 
Accuracy Assessment 对话框： 
1、Edit →Create/Add Random Points 
2、打开 Add Random Points 对话框 

 

    3、在 search Count 中输入 1024 
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    4、在 Number  of Points 中输入 20 

    5、在 Distribution  Parameters 选择 Random 单选框 

    6、OK（按照参数设置产主随机点），返回 Accuracy Assessment 对话框 

    可以看到在 Accuracy Assessment 对话框的数据表中出现了 10 个比较点，每个点都有点号、X＼Y

坐标值、Class、Reference 等字段，其中点号、X／Y 坐标值字段是有属性值的。 

说明：在 Add Random Point 对话框中， search  Count 是指确定随机点过程中使用的最多分析像

元数，当然这个数目一般都比 Number of Point 大很多，Number of Points 设为 20 说明是产生 20 个随

机点，如果是做一个正式的分类评价，必须产生 20 个以上的随机点。选择 Random 意味着将产主绝对随

机的点位，而不使用任何强制性规则。Equalized Random 是指每个类将具有同等数目的比较点。

stratified  Random 是指点数与类别涉及的像元数成比例，但选择该复选框后可以确定一个最小点数

（选择 Use  Minimum  Points）,以保证小类别也有足够的分析点。 

 

    第七步：显示随机点及其类别 

Accuracy Assessment 对话框： 
1、View./Show All(所有随机点均以第五步所设置的颜色显示在视窗中) 
2、Edit→Show Class Values（各点的类别号出现在数据表的 class 字段中） 
 
第八步：输入参考点的实际类别值 
Accuracy Assessment 对话框： 
1、在数据表的 Reference 字段输入各个随机点的实际类别值（只要输入参考点的实际分类值，它在

视窗中的色彩就变为第五步设置的 Point With Reference 颜色） 
 
第九步：设置分类评价报告输出环境及输出分类评价报告 
Accuracy Assessment 对话框： 
1、Report/Options，通过点击确定分类评价报告的参数 
2、Report/Accuracy Report（产生分类精度报告） 
3、Report/Cell Report（报告有关产生随机点的设置及窗口环境），所有报告将显示在 ERDAS 文本编

辑器窗口，可以保存为本文件 
4、File/Save Table（保存分类精度评价数据表） 
5、File/close （关闭 Accuracy Assessment 对话框） 
通过对分类的评价，如果对分类精度满意，保存结果。如果不满意，可以进一步做有关的修改，如

修改分类模板等，或应用其它功能进行调整。 
 

四、实验成果 
监督分类图 
评价分类结果图 
 

实验十一 地形分析方法 

一、目的 
对图像进行各种空间分析，进行像元之间或专题分类之间的空间关系处理，使处理后的图像能够更好地

表达主要的专题信息；以 DEM 为基础，完成相关地形分析。 
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二、要求 
掌握相关原理，并用软件完成相关操作 
 

三、方法与步骤 
菜单 Interpreter/GIS Analysis/ 
练习一、邻域分析 
输入文件：lnlandc.img； 
练习二、查找分析 
输入文件：lnlandc.img； 
Classes：4 
Distance to Search：10 
练习三、指标分析 
输入文件 1：lnslope.img；Weighting Factor：5 
输入文件 2：lnsoils.img；Weighting Factor：10 
Area：Union  Output：Unsigned 8 bit 
练习四、叠加分析 
输入文件：lnlandc.img；lnput.img 
Output：Thematic 
练习五、归纳分析 
输入分区文件：lnlandc.img；输入分类文件：lnslope.img 
确定输出选择：Output Report Only 
确定输出报告文件： 
打开报告文件：菜单 Tools/Edit Text File 
 
练习六、建立地形表面（Surface） 

1、Interpreter| Topographic Analysis| Surface 
2、File| Read 
3、Source File Type:ASC File 
4、Source File Name:Inpts.dat 
5、OK 
4、Field Type：Delimited by Separator； Separator Character：Comma； 

Row Terminator Character：Return New Line(DOS)； Number of Rows to Skip：0 
x,y,z 分别对应 2,3,4 

5、OK 
6、Surface| Surface 
7、Output File：testsurface.img 
8、OK 
 

练习七、坡度分析（Slope） 
以 DEM 栅格数据为基础进行地形坡度分析时，DEM 图像必须是具有投影地理坐标、而且其中高程

数据及其单位必须是已知的。如果 DEM 图像中平面坐标为经纬度，而高程坐标为距离单位，坡度分析

将无法进行。 
1、Interpreter|Topographic Analysis| Slope 



《遥感图像处理》实验指导书              苏州科技学院 环境科学与工程学院 空间信息与测绘工程系  杨朝辉编写 

 28

2、Input DEM File:demmerge_sub.img 
3、Output File:demmerge_slope.img 
4、Select DEM Layer:1 
5、Elevation Units:Meter 
6、Output Units:Degree 

 
练习八、坡向分析（Aspect） 
输入 DEM 文件：demmerge_sub.img 
输出选项（Output）：Thematic 
练习九、高程分带（Level Slice） 
输入 DEM 文件：demmerge_sub.img 
练习十、地形阴影（Shaded Relief） 
输入 DEM 文件：eldodem.img；叠加图像文件：eldotm.img；选择叠加颜色：R4,G3,B2 
练习十一、地形校正处理（Topographic Normalize） 
输入图像：eldoatm.img；输入 DEM 文件：eldodem.img 
Solar azimuth：315； solar elevation：45； output：Unsigned 8 bit 
练习十二、栅格等高线（Raster Contour） 
输入 DEM 文件：eldodem.img 
 

四、实验成果 
一般分析方法成果图、地形分析成果图 
 

实验十二 空间建模与实践 

一、目的 
应用直观的图形语言在一个页面上绘制流程图，并定义图形分别代表输入数据、操作函数、运算规则和

输出数据，生成一个空间模型，应用这些指令进行遥感图像处理。 
 

二、要求 
使用 SML 模型语言，利用模型生成器进行编辑，并执行形成的图形模型所设计的各种功能。 
 

三、方法与步骤 
 
图标 命令 功能 

 Select 选择和定义对象图形 

 Raster 放置栅格影像对象图形 

 Vector 放置矢量对象图形 

 Matrix 放置矩阵对象图形 

 Table 放置表格对象图形 

 Scalar 放置等级参数对象图形 

 Function 放置函数操作对象图形 
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 Criteria 放置条件函数对象图形 

 Connect 连接对象图形与函数操作 

 Text 放置模型文字描述 

 Help 模型操作联机帮助 

 Lock 锁住选择工具 

 Unlock 释放选择工具 
 
练习一、建立对象图形 
1、放置对象图形 

（1） 单击 Raster 图标，放置一个栅格图形 
（2） 单击 Matrix 图标，放置一个矩阵图形 
（3） 单击 Function 图标，放置一个函数图形 
（4） 单击 Raster 图标，放置一个栅格图形 
（5） 单击 Connect 图标，并单击 Lock 图标 
（6） 绘制连接线，如下图所示 

 

2、定义参数与操作 
（1） 双击左上方栅格图形，确定输入图像为 spots.img，OK 
（2） 双击右上方矩阵图形，选择内置型矩阵为 Built_In，选择内置卷积核为 Summary，选择卷积

核大小为 5×5，OK。 
（3） 双击中部函数图形，如图设置 
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（4） 双击最下面的栅格图形，确定输出图像为 spots_summary.img；Data type 为 Unsigned8-Bit；

File Type 为 Continuous 
3、保存图形模型 
File/Save As 为 1.gmd 
4、运行图形模型 
Process/Run 
5、查看结果，与原图像 spots.img 叠加显示 
 
练习二、注释图形模型 
单击 Text 图标，在图形模型窗口中，单击对应对象 
 
练习三、条件操作函数的应用 
1、 放置图形 

 

2、定义图形对象 
左上方栅格图形：dmtm.img 
右上方栅格图形：slope.img 
条件函数图形：如下图设置 

 
输出栅格图形：Data Type：Unsighed 4 Bit；File Type：Thematic 
3、保存图形模型 
File/Save As 为 2.gmd 
4、运行图形模型 
Process/Run 
5、查看结果，与原图像 dmtm.img 叠加显示 
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四、实验成果 
空间建模过程图和各练习运行结果图 
 
 

附加实验 三维虚拟 GIS 
 
 
 


